STEP-BY-STEP

1. Receive SharePoint address via email. Your address will be: https://researchsp.ern.nps.edu/sites/NPSusername/default.aspx
2. Upload draft thesis to SharePoint. Send email to ThesisDraft@nps.edu for Initial Review. (SharePoint will not alert us automatically.)
5. Notify your thesis processor directly (NOT ThesisDraft@nps.edu) when you are ready for a final review. Allow a minimum of four business days for final review.
6. Review final pdf file when prompted by your processor. Email your approval.
7. Watch for “Thesis Accepted” email from Python—you’re finished!

OUR WEBSITE
www.nps.edu/research/research1.html

THESIS STAFF
Sue Hawthorne, Library 111
sjhawtho@nps.edu
656-2159

Michele D’Ambrosio, Library 111
mdambros@nps.edu
656-3876

Aileen Houston, Library 111
abhousto@nps.edu
656-2411

Janice Long, offsite
jrlong@nps.edu

TARGET SUBMISSION DATES

JUNE GRADS:
Initial draft by May 8
Final draft by June 5
Ph.D. acceptance by June 8
Graduation is June 19

SEPTEMBER GRADS:
Initial Draft by Aug 14
Final Draft by Sep 11
Ph.D. acceptance by Sep 14
Graduation is Sep 25

DECEMBER GRADS:
Initial Draft by Nov 6
Final Draft by Dec 4
Ph.D. acceptance by Dec 7
Graduation is Dec 18

DISTRIBUTION
Your thesis publication announcement will be emailed to the addressees you list in your Publication Announcement List file. The library keeps one printed copy and adds your thesis to its online catalog. The Defense Technical Information Center will also catalog your thesis.
THESIS ROUTING START TO FINISH

WORKING DRAFT
For Initial Review*†

THESIS PROCESSOR
Distribution statement
Format of paper
Punctuation/spelling/grammar
Citations, reference list

ADVISOR/READER/CHAIR
Does content make sense?
Methodology/evidence/sources
Is paper well organized?

SIGNATURES OBTAINED

FINAL DRAFT
+ Publication Announcement List
+ Release Form**

Allow minimum of four business days

THESIS PROCESSOR

FINAL PDF

THESIS ACCEPTANCE EMAIL 😊

* At least six weeks before graduation day. Only FORMAT and HS students with editors are excused from the Initial Review.
† International students are strongly encouraged to use the available no-cost editing services.
** At least two weeks before graduation day.
TEMPLATE SETUP

Mac Settings:

Downloading/uploading file from your SharePoint site
- When saving a file on Mac in preparation for upload to SharePoint, use “Save As,” and uncheck “Hide extension.” (Older versions will say “Append file extension”—checkmark it.) Also, checkmark “maintain compatibility” if given the option.

Turning Off Auto Formatting Options MANDATORY
- From the Word menu, select Preferences
- Select the AutoCorrect icon
- Select the AutoFormat as you Type tab
- Under Apply as you type, and Automatically as you type, de-select all options
- Select OK (disables all autocorrect features in Word).

Turning Off Keep Track of Formatting MANDATORY
- From the Word menu, select Preferences
- Select the Edit icon
- De-select Keep Track of Formatting. Click OK.

Displaying the Style List
- Click View, then Styles
- Under “List,” select “Recommended”
- To highlight the styles applied in your document, click on “Show Styles Guides.”

Word 2013 and 2010 Settings:

Saving Template for the First Time MANDATORY; TEMPLATE BREAKS IF NOT DONE
- If prompted to upgrade to the new file format, click Cancel. The “Save As” screen will appear. See next bullet.
- When prompted to save, checkmark “Maintain Compatibility with Previous Versions of Word” if the option is available. If you save immediately after clicking on the website link, you may not see this option; that is okay—just click “Save” and choose a location.

Turning Off AutoNumbering MANDATORY
- From the File menu, select Options
- From the left column, select Proofing
- In the dialog, select the AutoCorrect button
- Select the AutoFormat As You Type tab
- Under Apply as you Type, de-select all options
- Select the AutoFormat tab
- Under Apply, de-select all options. Click OK.

Turning Off Keep Track of Formatting MANDATORY
- From the File menu, select Options
- From the left column, select Advanced
- In the dialog, turn OFF Keep Track of Formatting. Click OK

Set Layout as 2007 MANDATORY
- From the File menu, select Options
- Select Advanced
- Scroll down to Compatibility Options
- You can select just this document or all of them under “Compatibility Options For”
- Under Lay out this document as if created in, select Microsoft Office Word 2007.
• To save, click OK

Add Back and Forward Buttons (use to maneuver between TOC [or figure lists] and document)
• From the File menu, select Options
• From the left column, select Quick Access Toolbar
• At Commands from, select Commands Not in the Ribbon (from the drop-down)
• From the left column, select Back, and then select Forward
• Select Add to (to add each to right column)
• Select OK. Forward and Back button icons are added to the upper-left corner toolbar display

Displaying the Template Style List
• Select the Home tab
• Under AA Change Styles icon (far right of display), select small arrow (bottom-right corner)
• The Template Style list will be displayed on the right side of the document
• To display the current style (when selecting a section of the document), select the Style Inspector icon (middle icon at bottom of style sheet display).

Word 2007 Settings:

Word 2007 is no longer supported. Download either 2010, 2013, or 2011 versions for free from the Technology Assistance Center’s website.
I. FORMATTING INSTRUCTIONS

A. TEMPLATE SETUP

The template contains the pages and styles to format your paper.

1. Download and save template. If “Maintain Compatibility with Previous Versions of Word” prompt is available, checkmark it.

2. Open the template.

3. Configure your Microsoft Word settings per “Template Setup” handout.

4. Click the Show/Hide button ¶ to see all formatting marks.

5. Click small arrow under the Double A button to bring up the list of styles.

B. HEADING STYLES

To each heading topic, apply the heading style (Heading 1, 2, 3, or 4) that corresponds to its level in your outline (see Figure 1). When you apply each heading style, the proper letter or number will automatically appear, and formatting will be applied. Figure 1 shows how the four heading styles display your thesis outline in the Table of Contents, once they are applied to thesis text. Important: please use headings only to introduce a new section of thesis text. PLACE PARAGRAPH TEXT UNDER EACH HEADING before introducing the next level of heading.

Figure 1. Heading levels and their associated styles.

Handout 3
• Note that Heading 3s and Heading 4s must be typed in upper and lowercase letters. Avoid using Heading 3s to make a numbered list. Use the List Number style or List Bullet style to accomplish that task.

• Heading 5 typically is used for subsections below the Heading 4 level (see Chapter II, p. 10). Heading 5 also may be used under any heading level to number a series of paragraphs (see Chapter II, p. 13).

C. BODY TEXT STYLES

To all paragraphs in the document, apply ALL PARAGRAPH style. There are styles for other elements (e.g., List Bullet, List Number) used within the body text.

1. Figures and Tables

Images should be styled as IMAGE. This centers the image and adds the correct amount of space above it; therefore, do not insert manual returns between your body text and the top of your images (see Figure 2).

![American Flag]

Figure 2. Fit images within the left and right margins, between paragraphs.

Tables created directly on the page in Word (such as Table 1) should be styled as Normal, not IMAGE. Insert a line space below the table and the next paragraph.

Table 1. Styles to use and caption placement for figures and tables.

<table>
<thead>
<tr>
<th></th>
<th>Style to Use</th>
<th>Caption Style to Use</th>
<th>Caption Placement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure</td>
<td>IMAGE</td>
<td>FIGURE CAPTION</td>
<td>Below</td>
</tr>
<tr>
<td>Table</td>
<td>Normal</td>
<td>TABLE CAPTION</td>
<td>Above</td>
</tr>
</tbody>
</table>
2. Captions

Apply FIGURE CAPTION style to figure captions, and TABLE CAPTION style to table captions (see Table 1 for placement). Word will update the Lists of Figures and Tables on command, as described for the Table of Contents. Each figure or table must be referred to by number in the text prior to displaying the figure or table. Do not use descriptive words such as “above” or “below” when referring to figures or tables; refer to the figure or table by its number.

a. Choose Title Case or Sentence Case in Captions

Captions may be either “Title Case” (capitalize all words except prepositions, articles and conjunctions) or “Sentence case” (only the first word and proper nouns capitalized); be consistent with your choice.

b. Use “from” and “after” with Caption Citations

For any figure or table that is not your original work, you must note the source in the caption. If the content is directly reproduced from a reference, use “(from ___).” If you have applied changes to the original, use “(after ___).” Follow the citation style you used elsewhere in your thesis. If the source to a figure or table appears only once in your paper, cite the source fully in the caption—it need not go in the List of References. Images found on the Internet should be cited fully; the URL alone is not sufficient.

Figure 3. Caption text here (from Author & Author, 2009) (APA)

Table 2. Caption text here, after [7]. (IEEE)

3. Quotes

Quotations of five or more lines are to be styled as Quote style. This enhances the readability of the quoted material.

The quotation becomes a separate paragraph. No quotation marks are placed around these quoted blocks [emphasis mine]. Ellipses are used only when the quotation starts or ends in midsentence. For quoted material within a block quote, use double quotation marks. Citations go outside the period for block quotes only, like this. [3]

Handout 3
4. **Bulleted and Numbered Lists**

Guidance for bulleted or numbered lists is as follows:

- Apply **List Bullet** style to bulleted lists and **List Number** style to numbered lists.

- To restart a numbered list at “1,” right click on the first item, and choose “Restart at 1.”

- Avoid using a mixture of bullets, numbers, or dashes, for different lists in your thesis.

- Bullets are preferred, but whatever you choose, use one type consistently.

- Generally, vertical lists are punctuated with periods only if the bullets consist of complete sentences.

D. **TABLE OF CONTENTS**

*Do not manually type your own Table of Contents.* After styling all headings in your thesis, **right-click** on the Table of Contents (text field turns gray).

1. **Select Update Field**

![Update Field Menu](image)
2. Then Select Update Entire Table

![Update Table of Contents window]

Each heading will appear in proper outline form.

A glance at the completed Table of Contents should provide an overview of the thesis and act like an outline but not weigh down the reader with detailed information.

E. REFWORKS, MENDELEY, AND THE LIKE

If you use reference-list generating software, such as RefWorks, ensure that you fill in all fields completely and accurately when creating your citation list. **You must edit the list for punctuation and formatting** once the footnotes (if you use Chicago footnote style) and List of References are imported. To edit most lists, you must remove the field code. Do this by pressing **Shift + Control + F9** at the same time. In Word’s citation manager, click on the list and choose “convert to static text.” See thesis processor for help.

**RefWorks/Write-N-Cite users:** Before submitting for Final Review, click option to “Remove Field Codes,” after importing the list of references (you will find this option under the “Tools” menu in Write-N-Cite). **Save a copy of the thesis for your records before removing the field codes.** See thesis processor or the library for help.¹

Also, RefWorks users must abandon the check-in/check-out feature of SharePoint. Instead, download the thesis from SharePoint, made edits, and then re-upload the file to SharePoint (Write-N-Cite cannot access files in password-protected sites such as SharePoint).

The library offers library citation management tools [here](#).

---

¹ Footnotes should be styled as “Footnote Text.”
F. BLANK PAGES

Place each new chapter on an odd-numbered page (this should be done before submitting for Final Review). You may need to remove or insert intentional blank pages to achieve this. To add a blank page, place the cursor after the last word on the current page, then press Control + Enter to insert a new page in your file. On the style list, click BLANK PAGE. Type “THIS PAGE INTENTIONALLY LEFT BLANK” (or copy and paste the text from an existing blank page).

G. CROSS REFERENCING

First, remove the period and tab from the FIGURE CAPTION and TABLE CAPTIONS styles (Style Palette → right click on style name → modify → format → numbering → define new number format).

Then, to insert a cross reference, in the References tab, click Cross-reference. Choose numbered item under “reference type,” and insert reference to “paragraph number.” To update the cross references as you work, select all text and press F9. Follow prompts to update all linked content.

Next, when you are sure all figures and tables are in their permanent positions, highlight all body text starting from page arabic number 1 and press Shift + Control + F9. This breaks the field code from the cross references. Finally, reinsert the period and tab in the FIGURE CAPTION and TABLE CAPTION style.

H. EQUATIONS

To create equations, use MathType, which you can download from the NPS Technology webpage. DO NOT use the Insert, Equation option in Microsoft Word because math symbols could disappear when the file is converted to PDF.

The most popular format for equations is to center them and place the equation number on right margin (choose “Right-numbered” equation in MathType to achieve this). Whether you number your equations is at your discretion.

\[ 5x=10 \]  

(1)

6

Handout 3

OVER →
If you created equations *outside* of MathType, follow these instructions:

1. Place your cursor in front of the equation, go to your style list, and choose either *Equation* or *MTDisplayEquation*.

2. Then, press tab. Your equation should jump to center of the page. If it does not, remove extraneous space and tab markings. There should be only one tab space.

3. Place your cursor *after* the equation and press tab. The cursor will jump to the right margin.

4. Now click *Insert Number* on the MathType menu if you want MathType to number your equations (to format the numbers, click *Insert Number*). Or, you can manually number your equations.
II. SAMPLE CHAPTER

This is how a properly formatted chapter would look. Each section of a chapter should be substantial enough to warrant a heading. There should be at least two sections per heading level. Do not stack headings without text in between. **Heading 5 style may be used under any heading level** if short, numbered paragraphs are desired.

A. **THIS IS A HEADING 2**

All paragraph style all paragraph style all paragraph style all paragraph style all paragraph style (citation), which therefore all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style (citation).

All paragraph style all paragraph style all paragraph style all paragraph style all paragraph style inventory life cycle style (citation) all paragraph style particularly all paragraph all style all paragraph its paragraph style all paragraph style used all paragraph style in the field. When paragraph style repeated paragraph all style all paragraph style plus all paragraph style; therefore, all paragraph style all paragraph style all those paragraph all style of style of consequence (citation). All DON and U.S. paragraph style (citation) all paragraph style all paragraph style (citation) belatedly that paragraph style; however, if enough style all paragraph solids all style paragraph style all continuing all paragraph style all paragraph style all paragraph style all paragraph style all paragraph they paragraph styled (citation).

Citation states all paragraph, style all paragraph. All paragraph style all paragraph style the paragraph style all paragraph style comprehensively all paragraph (citation) style all paragraph style all paragraph the system of systems paragraph all style all paragraph style all DOD the authors relate style but in truth all style all the experiment paragraph style (citation).

1. **Heading 3**

All paragraph style all paragraph style all paragraph style all paragraph determine (citation) paragraph style all paragraph style; however, all paragraph style all and paragraph style all paragraph style all paragraph style all paragraph style all paragraph style (citation). All
understand style their paragraph style all paragraph style; indeed, paragraph style paragraph style all paragraph narrative style all paragraph style all paragraph style all repeat paragraph all this thesis style all paragraph style all paragraph style (citation). Then paragraph style for what it is worth, all counterterrorism style all paragraph style all paragraph style (citation); all paragraph security style all paragraph style all paragraph style but all paragraph style all paragraph style all paragraph style (citation). All insert style all paragraph (citation). All paragraph style all paragraph style shown paragraph design paragraph style all paragraph style, again, certainly, all what does the new paragraph style all paragraph style all paragraph style all paragraph style all paragraph style (citation).

All paragraph style all paragraph current research project (citation). All paragraph style all paragraph style all paragraph style (citation), and all paragraph style all paragraph style all paragraph style all paragraph style all paragraph; later, it was found such all (citation) that paragraph style all intelligence that all paragraph style all paragraph style.

\[ a. \quad \textit{Heading 4} \]

All paragraph style all government office all paragraph style all paragraph style (citation) all paragraph style all paragraph style. Citation all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style, ultimately. All paragraph beyond paragraph style all yet paragraph style words all paragraph all style all whereas style and paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style (citation).

All paragraph style all paragraph current research project. All paragraph different paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph (citation); later, it was found such style all paragraph style all intelligence that all paragraph style all paragraph style.

(1) \quad \textit{Heading 5 Used as Subsection under Heading 4}

All paragraph style all paragraph. In all paragraph all style all paragraph all style all paragraph style all paragraph, respectively, all style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all Homeland Security paragraph style (citation).
All paragraph style all paragraph. All paragraph style all paragraph style all miles. Paragraph style all—paragraph style all paragraph—style all paragraph all style that paragraph style all paragraph style all paragraph. Style all paragraph style all paragraph style (citation), but then paragraph style all paragraph all style all paragraph and all paragraph style all paragraph; however, all paragraph style.

(2) Heading 5 Used as Subsection under Heading 4

All paragraph style all paragraph. All paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all cyclonic style all paragraph style all other paragraph style all paragraph style all paragraph style (citation). All paragraph style all paragraph (citation). All deleted paragraph style all paragraph style all paragraph style all paragraph style all paragraph style jargon (citation) all paragraph perhaps paragraph style all jargon style all paragraph style all paragraph style all paragraph style all paragraph style (citation). All paragraph style all paragraph. All paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph intended paragraph style all paragraph data style all paragraph style all paragraph style all paragraph style (citation).

b. Heading 4

As reported by Citation, all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all atmosphere style all paragraph style all paragraph style (citation).

All paragraph style all paragraph. All paragraph style all paragraph style all paragraph style (citation), all paragraph style (citation), and all paragraph style plus paragraph style (citation) all paragraph style all paragraph (studies show style all paragraph style).

All paragraph style all paragraph and then a (citation). All paragraph style after paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style (citation).
2. **Heading 3**

All paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style. Citation all paragraph style all paragraph therefore paragraph style all paragraph all style all paragraph style all paragraph all style the paragraph style all paragraph style all paragraph style all paragraph style all paragraph style, ultimately. All paragraph style all beyond paragraph style then (citation) style all yet style yet words all paragraph style all paragraph style and paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style (citation).

All paragraph style all paragraph style because (citation) all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style; therefore, all paragraph style all paragraph (citation) monograph style all paragraph style all paragraph style all and paragraph style. All paragraph style besides all paragraph style all cubesat style, because and all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style. All paragraph style all paragraph (citation). All and paragraph style all paragraph style paragraph style including (citation) style all paragraph style all kilometers paragraph style all paragraph style all paragraph style all paragraph style all paragraph style there paragraph style all paragraph style.

All paragraph style all paragraph style all paragraph style all paragraph whether paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph usually style all paragraph style (citation). All paragraph style all paragraph new style all paragraph style all paragraph style all paragraph when it is done style all paragraph does not all paragraph style all MATLAB style all paragraph style all data thereafter style all paragraph style. All paragraph style all paragraph style (citation) paragraph style all paragraph style all would not therefore be paragraph all style all paragraph style all paragraph style paragraph style all paragraph style could style all paragraph style all paragraph style (citation). Once all paragraph should paragraph (citation). Style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph discovered paragraph style all paragraph style all paragraph style all paragraph before paragraph style states that style.
B. THIS IS A HEADING 2

All paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style; however, all paragraph style all and paragraph style all paragraph style all paragraph style all paragraph style all paragraph style (citation). All paragraph style (citation) their paragraph style all paragraph style; indeed, paragraph style demonstrated all paragraph narrative style all paragraph style all paragraph style. All paragraph style for what it is worth, all paragraph style all paragraph style all paragraph style (citation) paragraph style all paragraph style all paragraph style all paragraph style but all paragraph style because then style all paragraph style. All paragraph style all paragraph. Citation all paragraph style all paragraph style all paragraph style America in particular, paragraph style, again, certainly, all what does new all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style, from Citation (citation) as follows.

(1) Heading 5 to Number Paragraphs (Optional Use)

All paragraph style all paragraph. All paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style. All paragraph style all paragraph style all paragraph style: all paragraph styles.

(2) Heading 5 to Number Paragraphs

All paragraphs style all paragraph. Surprisingly, all paragraph style all investigate style all paragraph style paragraph style could not comply all paragraph is all paragraph style. All paragraphs style all paragraph. All paragraph all style the known paratrooper experiment paragraph style all and paragraph style toward paragraph style all potato and therefore style all paragraph style all decided paragraph style all paragraph published. Paragraph style all. The paragraph style all paragraph style: all paragraph styles all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style.

(3) Heading 5 to Number Paragraphs

All paragraph style all paragraph. All paragraph style all paragraph style who paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style. All
should paragraph style all paragraph. All paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style. Afterward, style all paragraph. All paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style that the paragraph style.

(4) Heading 5 to Number Paragraphs

All paragraph style all paragraph. All paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style all paragraph style. All paragraph style all paragraph. All paragraph style all paragraph style all paragraph style all paragraph.
USING SHAREPOINT

All on-site NPS students must use SharePoint

<For access issues, call TAC HelpDesk at 656-1046>

**To work from home or wirelessly, you must log onto the NPS network first. Install the software from the NPS Technology web page.**

**If prompted for your username, enter “ERNI” before your username: ERNijdoe**

**Use one SharePoint site per paper. If there are co-authors, choose one person’s site to use.**

Upload Thesis
Go to SharePoint site (link is emailed to you by your graduation quarter)
- Select Upload
- Select Browse, locate your thesis file (from your hard drive/disc), select Open
- Select OK
- Select Check In

*Important:* Check In is a must or file cannot be checked out and edited by others

Check Out and Edit

ONLY work in the current file from SharePoint, and Do NOT rename the file (keep the filename that specifies your graduation year/month). If you wish to keep each version on your computer, upload the finished new file first. Then download a copy to your computer and rename as desired for your archives.

Firefox or Mac: It is not possible to check your file in or out of SharePoint. Instead, open the file from SharePoint, save it to your hard drive, edit the file from your hard drive, then upload the edited file back into SharePoint. When saving a file on a Mac, in preparation for upload to SharePoint, ensure “Hide Extension” at bottom left is NOT checked (older versions of Word may offer an “Append file extension” block—checkmark it).

Internet Explorer:
- Place your cursor over the document you want to check out
- On the right side of the document name, select the down arrow
- From the drop-down, select Check Out
- If you receive a prompt, verify that “Use my local drafts folder” is NOT selected, then select OK
- Again, place your cursor over the Word document, and select the down arrow
- From the drop-down, select “Edit in Microsoft Office Word”
- The Word document opens and is available for editing
- When finished, click the X in the upper-right corner (to close the file)
- When prompted, select Save Changes and Check In (comments are optional)
- The file has been checked back into SharePoint, and Version History has been updated

Handout 4
Download from our website; electronic or hand signatures acceptable; if hand signed, please scan completed hard copy into pdf format. Upload form to SharePoint site when ready to request final review.

OPTIONAL: Color Request Form, download from our website
COMMON ERRORS: WE MARK—YOU FIX

Cover Page
- Do not include titles for advisors or rank for military on this page
- For distribution statements with restrictions, include separate parentheses around reason and date; select your reason from the DTIC list on our website
- Make certain advisor and second reader information matches the signature page

Documentation Page
- Ensure your title exactly matches the titles on Cover and Title pages
- Ensure abstract is identical to the Abstract page in the thesis
- Include IRB Protocol Number in block 11, if human-subject review was done, or insert "N/A"

Table of Contents
- Right-click and select Update Field to refresh Table of Contents; verify headings and sequence of numbering/lettering
- Check that all chapters start on odd-numbered pages. Insert or delete blank pages as needed

Lists of Figures/Tables
- Verify that figures/tables are numbered in sequence
- Check that no actual figure/table images appear in the list; for any that do, scroll to that page, click on graphic itself and apply the IMAGE style (figures) or Normal style (tables); return to List and Update Field again; check that figure or table image has been removed from list

Punctuation
- Make sure commas and periods are INSIDE quotation marks
- Check for commas in dates (comma after day as in May 10, 2009, but not after month as in May 2009 or 10 May 2009)
- Place a comma after i.e., and after e.g., always
- Et al.—no comma before et al., no period after et; always period after al.
- Check that apostrophe is used for possessive case (exception: it’s means “it is”)
- Do not use contractions
- When referring to plural years, as in the 1990s, do not use an apostrophe

General
- Master’s has an apostrophe, thesis is lowercase, and Postgraduate is one word
- Avoid starting a sentence with “however,” “and,” or “because”
- When typing a date, do not use “st” or “th,” as in December1st or 5th
- Spell out numbers one through nine. Use numerals for 10 and greater
- Capitalize C in Chapter, S in Section, F in Figure, T in Table, E in Equation, and A in Appendix when referring to specific chapters, sections, figures, tables, equations or appendices in the text; use roman numerals for chapters: Chapter IV
- Footnote numbers go outside the punctuation, with no space: Like this.20
- When equations occur within sentences, use proper punctuation, and the very next line should not be indented
- Use the tab key (not the space bar) for headings: B.[TAB]SCOPE OF WORK
• Eliminate all track changes before each processor review
• Be consistent with spelling out or abbreviating states and dates; do not mix
• Use DOD (uppercase O), not DoD; U.S. (periods after each), not US
• If you have quoted material five or more lines in length, put into block quotation using Quote style. Remove quotation marks around these block quotations. Use ellipsis marks only where quotation begins or ends mid-sentence
• If you are using ranges of numbers (or dates), use EN dash to separate (not hyphen) and no spaces around EN dashes: 1990–2010, January–April
• Make sure paragraphs are all either justified or flush left, and not double-spaced
• Make sure the font is consistent throughout

Figure and Table Errors to Avoid
• Set figure and table layout as “In line with text”: right click on image, select Format Picture, Layout, In line with text (this will keep paragraphs from splitting around images, and content from hiding beneath images)
• Insert figures and tables between paragraphs, after they are cited in the text
• When citing a table or figure in text, use its number: Table 1, Figure 12; do not say “the following table/figure” or include “above” or “below”
• Center figures and tables between margins (check for and remove paragraph indents by sliding margin-set triangles to left margin of the ruler)
• Make sure images fit within the margins of the document. Reduce as needed, or change page to landscape orientation for a larger image
• Place figure caption below the figure. Table captions should be above tables.
• If your graphic is taken from another source, always identify whether it is “from” or “after” in the caption: (from Smith, 2010); use “after” if you made any changes

Footnotes
• Spell out the month, or at least be consistent with date formats throughout
• Make all URLs live hyperlinks (blue) or not live (black)—do not mix
• Make sure hyperlinks in footnotes are 10 point and font matches thesis
• Footnotes should not split across pages (look for extended separator line)
• “Ibid.” has a capital I and is NOT in italics; there is always a period after Ibid.
• Put comma and space between Ibid. and page number: Ibid., 10

References
• If a reference begins with “The,” alphabetize that reference using the next word in the company/group name: i.e., The Rand Group would be alphabetized by “R”
• If a reference begins with quotation marks (i.e., with a title rather than an author) alphabetize by the first letter after the opening quote symbol
• Put a period at the end of each reference (EXCEPTION: references ending with a URL, if using APA or IEEE styles)

Master File Protection
• Your file on SharePoint is your Master file. Only you and your Thesis Processor should update your Master file. We highly recommend giving your advisor/second reader a separate e-copy (or hard copy) for review, then incorporating their edits/revisions into your Master file.
• If your advisor/second reader chooses to use SharePoint to edit your thesis, make sure to walk him/her through the Template Setup instructions before starting work; this will minimize the risk of corrupting your formatting.
Each of the following departments has a required or preferred citation style for theses, dissertations, capstone reports, and/or final project reports. If a department or program is not listed below, then students either are allowed to choose a recognized citation style or will be directed to use a particular style by their advisors. *We recommend students check with their advisor at the thesis proposal stage.*

### Required or Recommended Thesis Citation Styles

<table>
<thead>
<tr>
<th>Department or Program</th>
<th>Citation Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquisition Research Program (ARP)</td>
<td>APA</td>
</tr>
<tr>
<td>Center for Homeland and Defense and Security (CHDS)</td>
<td>Chicago (notes-bibliography system) preferred, but any recognized style will be accepted</td>
</tr>
<tr>
<td>Cyber Systems and Operations (CSO/MACO)</td>
<td>IEEE preferred, but any recognized style will be accepted</td>
</tr>
<tr>
<td>Defense Analysis (DA)</td>
<td>Chicago (notes-bibliography system) preferred but any recognized style will be accepted</td>
</tr>
<tr>
<td>Electrical &amp; Computer Engineering (ECE)</td>
<td>IEEE**</td>
</tr>
<tr>
<td>Engineering (if not listed separately)</td>
<td>IEEE</td>
</tr>
<tr>
<td>Mechanical &amp; Aerospace Engineering (MAE)</td>
<td>Recognized citation style preferred by advisor. Department prefers AIAA and ASME.</td>
</tr>
<tr>
<td>Meteorology and Operational and Oceanography (METOC)</td>
<td>AMS</td>
</tr>
<tr>
<td>Information Sciences (IS)</td>
<td>APA preferred, but advisors may determine another citation style is necessary</td>
</tr>
<tr>
<td>Human Systems Integration (H.S.I.)</td>
<td>APA</td>
</tr>
<tr>
<td>National Security Affairs (NSA)</td>
<td>Chicago (notes-bibliography system)</td>
</tr>
<tr>
<td>Operations Research (OR)</td>
<td>Some OR advisors require INFORMS</td>
</tr>
<tr>
<td>Systems Engineering (SE)</td>
<td>Chicago (author-date system)</td>
</tr>
</tbody>
</table>

* Thesis refers to theses, dissertations, final project reports, and capstone reports.

** In ECE, the abbreviation "et al." is not to be used in the List of References, although it can be used in the thesis body.

### Current Citation Guides Online and in Hard Copy:
For examples of how to cite various source types in each citation style, see: [http://libguides.nps.edu/citation](http://libguides.nps.edu/citation). The examples were created based on experience with student papers and theses. This Dudley Knox Library (DKL) site also includes links to online style guides.
Links to online style guides can also be found on the GWC resources website at https://my.nps.edu/web/gwc/citations. The GWC collection in the library includes the most recent hard-copy version of citation style guides used by NPS students.

Notes from the Thesis Processing Office:

1. When other citation styles are silent on how to properly cite a source, the TPO defers to Chicago, which is the most complete of the established guides.

2. Tools such as RefWorks are useful, typically getting users’ citations 80–85 percent correct; however, proofreading and editing by the author(s) are still needed. The library offers RefWorks workshops each term. See http://www.nps.edu/library/Services/Instruction/LibraryWorkshops.html.

3. As the publisher of NPS theses, the TPO reviews thesis citations for the following, in order of importance and effort: 1) avoiding plagiarism, 2) complete source information, 3) chosen citation style followed correctly, and 4) consistency within a document.

Notes from the Graduate Writing Center:

Class Papers: If teaching faculty do not require a specific citation style for course papers, the GWC suggests that students practice using their department’s or advisor’s chosen thesis citation style while writing class papers; practice should make formatting and citing less daunting during the thesis process.

Additional Citation Guidance: The GWC website includes handouts and videos to help students understand plagiarism and the rules and norms for citing sources. Please see “Writing Resources by Topic” at https://my.nps.edu/web/gwc/resources.

Citation-related Workshops: The GWC offers two workshops related to citing. Nailing Your Citations explains why to cite, when and what to site, and how to cite. Paraphrasing and Quoting Effectively, new starting winter 2015, provides tips, techniques, and practice paraphrasing, quoting, and summarizing sources that need citations. For more information and to sign up, see: https://my.nps.edu/web/gwc/workshops.

Reference Materials: The GWC citations page also includes the following reference materials: Common Military Acronyms, (U.S. Army), DoD Dictionary of Military Terms (DOD), Latin Terms and Abbreviations (University of North Carolina at Chapel Hill Writing Center, and Military Acronyms, Initialisms and Abbreviations (Federation of American Scientists).